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Get Started Day Trading 
By John Paul of Day Trade to Win 

 
http://daytradetowin.com  | support@daytradetowin.com |  1-888-607-0008 

 

Have you ever heard of futures or currency trading? 

Ever considered day trading for part-time or full-time income? 

Yes, it is possible to make a living day trading.  John Paul, founder and lead 

educator at Day Trade to Win, knows because he’s done just that.  By learning how to 

recognize specific market conditions while minimizing risk, you can become 

consistently profitable.  We will teach you how.  

We’ve helped thousands of people like you who have never day traded.  Yes, it will 

take a little bit of time to learn, but so does anything worthwhile.  This guide will get 

you set up as quickly as possible.  If you come up across unfamiliar terms, we 

recommend using investopedia.com or our FAQ page as a dictionary. 

By the end of this guide, you will be up and running with proper day trading software 

and real, live data for your charts.  You see real-time price movement as it plots just 

like a professional trader.  You will also learn three trading methods you can use with 

your charts.  Using these methods you can practice “paper trading,” aka placing simulated trades.   

Remember, when trading real money, there is substantial risk of financial loss.  Only trade with money you can 

afford to lose.  Please read the full disclaimer at the end of this document.  Simulated trading is not indicative 

of live trading results.  Past performance is not indicative of real-time or future results. 

 

Part 1 – Day Trading Explained 

 When we talk about day trading at Day Trade To Win, we are referring to trading futures and currencies 

from your personal computer.  You sit at your computer looking at charts, waiting for price patterns to 

occur.  By recognizing these specific patterns, also called “setups,” you know when and how to place 

your trades.  These are the methods we teach – all based on price patterns.  This is also called price 

action trading.  We believe price action trading has benefits over other types of strategies and systems 

that overcomplicate and confuse traders. 

 

 Trading software, also called a trading platform, is your way to see charts of various markets.  Our 

recommended trading software is NinjaTrader.  We recommend NinjaTrader because of its efficiency 

and flexibility.  In NinjaTrader, markets such as the E-mini S&P and Euro FX are also referred to as 

“instruments.” 

 

  

http://daytradetowin.com/
http://investopedia.com/
file:///C:/Users/Admin/Desktop/daytradetowin.com/faq.php
http://daytradetowin.com/
http://daytradetowin.com/mentorship.php
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 Indicators are third-party scripts and programs made by individuals and trading companies.  Indicators 

plug into trading platforms and intend to provide traders with greater insight.  Indicators can also be 

problematic.  Too many indicators can clutter your chart or provide inaccurate advice.  Many times, 

traders become too reliant on indicators without understanding the underlying strategy.  At Day Trade 

to Win, we make sure you understand how to recognize profitable trading opportunities so you don’t 

blindly follow an indicator.  Most of our courses come with indicators that can be used as a reference to 

confirm the strategy.  Our most popular indicator is called the Atlas Line. 

 

 Using the NinjaTrader software, you place trades in “sim 

mode” by default.  This is paper trading.  Paper trading with 

real-time, live data is the best way to practice because it 

closely resembles live trading with real money.  With either 

real or simulated trading, NinjaTrader provides a performance 

history of your trades in the Account Performance tab. 

 

 To trade live with real money, you need to set up an account 

with a broker.  Before trading with real money, we 

recommend that you practice trading until you are 

completely confident.  Brokerages are separate companies 

outside of NinjaTrader.  The broker will require that you 

deposit money into the account to trade with.  The broker will 

provide you with a connection to the markets (a data feed) 

and a user name and password for NinjaTrader.  Each broker has specific requirements for leverage 

and margins.  Also, brokers will charge a round-turn fee to handle each trade you make. On average, 

each trade’s round-turn rate is about $3.90 to $4.30 per trade depending on the broker.  The complete 

costs for day trading are discussed later on. 

 

A NinjaTrader five-minute chart showing the Atlas Line indicator from Day Trade to Win

 

  

 

www.ninjatrader.com 

http://ninjatrader.com
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Part 2 – Day Trading Requirements 

 You will need a computer purchased within the last four years or so.  Your computer should have at 

least 4GB of memory and Windows 7 or 8.  NinjaTrader does support XP or Vista, but you are better off 

with a newer computer.  Since you will be potentially placing live trades worth thousands of dollars, it’s 

a good idea to make sure your computer is as fast and reliable as possible.  Use an anti-virus / anti-

malware program to clean up your computer.  Also, reduce the amount of programs that are running 

simultaneously (to free up memory).  A single monitor will suffice since you will be looking at one 

market in the beginning.  You will also need a fast, stable internet connection.  A cable, DSL or fiber 

optic connection will work just fine.  Have a technically skilled family member, friend, or a professional 

help optimize your computer. 

 

 Patience and time to learn.  Learning to day trade will take time.  We believe the best time to trade is 

when the market opens.  The E-mini S&P 500 opens at 9:30 a.m. US/Eastern and is best for trading 

until noon US/Eastern.  Our methods work outside of these hours, so if you are doing other things 

during this time, no need to worry.  If you are busy all the time, you can practice at your leisure using 

NinjaTrader’s Market Replay.  This feature lets you replay market data back so you can practice as 

though the data is live. 

 

 For live futures trading, you can open an account for as little as $2,500 depending on the broker.  We 

recommend a minimum account size of $4,000 to absorb losses.  When trading live, we recommend 

you start with one futures contract and then increase as you learn and become successful.  Remember, 

if you’re new to trading, you shouldn’t open an account right away.  You can paper trade for free. 

 

 A plan.  You can’t expect to be successful guessing trades. See our day trading courses and software 

for a variety of strategies that work.  You can practice our strategies by paper trading live data. 

 

 Proper support.  Use the following websites to answer your questions: 

 

http://www.daytradetowin.com/faq.php 

Our FAQ page with explanations of popular trading terms and tips on how to trade. 

 

http://www.daytradetowin.com/blog 

Our Blog with tips and current events that affect trading. 

 

http://www.ninjatrader.com/support/helpGuides/nt7/index.html?video_library.htm 

Want to learn how to use NinjaTrader?  The video library is the place to do it. 

  

http://www.investopedia.com 

Want to look up a day trading term?  Here’s the place. 

 

http://www.cmegroup.com 

The official site of the CME (Chicago Mercantile Exchange).  Everything you want to know about the E-

mini and other popular futures. 

  

http://www.wikipedia.org 

You have probably used Wikipedia already.  It’s the largest single site for information. 

 

http://daytradetowin.com/courses.php
http://www.daytradetowin.com/faq.php
http://www.daytradetowin.com/blog/
http://www.ninjatrader.com/support/helpGuides/nt7/index.html?video_library.htm
http://www.investopedia.com/
http://www.cmegroup.com/
http://www.wikipedia.org/
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So you want to eventually trade live – but what are the costs? Here is a summary: 

 

1. $4,000 account with a broker for trading up to two futures contracts with even room for 

accommodate for losses during the learning process.  We recommend that you start trading with 

one contract and then move to two once you feel comfortable. 

 

2. A Live NinjaTrader License.  Currently, you can lease NinjaTrader for $50 a month or own it for 

$995.  Payment options are available.  Note that if you plan to switch brokers, it is good to 

purchase a Multi-Broker license for more freedom.  Click here for all the NinjaTrader purchasing 

options.  Remember, you can paper trade all you want for free – this is discussed later. 

 

3. Broker round-turn fee.  Expect to pay around $4.30 per trade per contract.  At this rate, if you 

trade two contracts, each trade will be $8.60. 

 

4. Of course, we recommend having a profitable strategy.  The six-month Atlas Line license is a 

great way to start.  

 

5. A reasonably fast, streamlined Windows computer with quick internet access to trade with. 

 

Part 3 – How to Get NinjaTrader and a Live Data Feed 

In order to day trade, you will need a trading platform.  We’ve already covered why we use NinjaTader.  

Remember, everything we will show you here is entirely free.  Now let’s get to it… 

1. Download NinjaTrader 7 from this link and save it to a folder that you’ll remember: 

http://www.ninjatrader.com/ninjatrader/nt7/setup.exe 

 

2. Run the setup program and follow the instructions to install NinjaTrader.  When NinjaTrader is finished 

installing, you should see two shortcuts on your desktop: NinjaTrader 7 and NinjaTrader 7 (64-bit).  The 

64-bit version is for computers that using a 64-bit version of Windows.  It can take full advantage of 

computers with 4 GB of memory or higher.  We recommend the 64-bit bit version, but the 32-bit will 

work just fine.  Double-click the NinjaTrader shortcut. 

 

3. When Ninjatrader opens for the first time, you will be asked for a license key.  Use this key: 

@SIM-F82F-D583-40B1-AE74-B79F-705D-1952 

 

4. When NinjaTrader is finished loading, you will see the NinjaTrader Control Center.  This is the “home 

base” that you can open charts from, establish data feed connections, review performance, and so 

forth. 

A word about NinjaTrader and its licensing – it’s free to use for simulated trading.  You only have to buy a 

NinjaTrader license when you are ready to trade live.  Click here to learn more about NinjaTrader licensing.  

Currently, you can own the software or lease it for $50 a month.  Once you decide on either owning or leasing, 

you can decide on purchasing a single-broker or multi-broker license.  A single-broker license is great if you only 

plan on working with one broker who will provide you with all the markets you want to trade.  A mult-broker license 

allows you to have multiple broker connections in NinjaTrader.  This is of benefit if you like to switch brokers for 

trading different markets. 

http://www.ninjatrader.com/purchase
http://daytradetowin.com/software.php
http://www.ninjatrader.com/ninjatrader/nt7/setup.exe
http://www.ninjatrader.com/purchase
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5. When NinjaTrader is finished loading, you will see the NinjaTrader Control Center.  This is the “home 

base” that you can open charts from, establish data feed connections, review performance, and so 

forth. 

 

6. To get live data on your charts, email us at support@daytradetowin.com for a live data feed.  Currently, 

we offer a 21 day trial of the CQG data feed.  CQG data feed is considered the gold standard among 

day traders.  Many brokers offer this feed.  The Vision / Rithmic feed, Zen-Fire feed, and Kinetick feed 

are also excellent.  You will know when it expires because you will get an error when connecting to the 

feed. 

 

7. Once you have your data feed user name and password, go to NinjaTrader’s Control Center > Tools > 

Account Connections > Add…> Next > For the connection name, type in “CQG” without quotes, under 

provider, select CQG, click Next > Type the user name and password you were provided, check Demo 

mode and Include index data, click Next > Finish. 

 

8. Now we will connect to the data feed.  You will need to connect to the data feed every time you open 

NinjaTrader (unless you clicked the “connect on startup” option when creating the data feed). To 

connect, go to NinjaTrader’s Control Center > File > Connect > CQG.  In about a minute, you should 

see “Connected – CQG” in green in the bottom left of the Control Center.  If you do not see this, you will 

need to check your internet connection or firewall. 

 

9. NinjaTrader can now receive live data.  You can confirm this without opening a chart.  In the Control 

Center, go to the Orders tab and next to Name, select the drop down item that begins with “ES.”  

Providing the market is not closed, you should then see price changing. 

ES is NinjaTrader’s symbol for the E-mini S&P 500.  To see a full list of symbols, go to NinjaTrader’s Control 

Center > Tools > Instrument Manager > Search using the name or description fields. 

The numbers next to the ES represent the contract month.  You will always want to trade the correct contract 

month.  The E-mini has four contract months (always the same every year).  For example, for 2013, 

NinjaTrader will use: March (ES 03-13), June (ES 06-13), September (09-13), and December (12-13).  

Contracts expire / rollover to the next contract on the second Thursday of these months.  On the expiration 

day, you will need to manually switch to the new contract month using NinjaTrader.  For information on how to 

roll over contracts, visit our FAQ page. 

 

Part 4 – Using Charts and Placing Trades 

In this example, we will open an E-mini S&P 500 chart.   

In NinjaTrader’s Control Center, go to File > New > Chart.  In the left panel, double click the ES.  The ES drops 

down to the bottom panel.  Click on it.  In the right panel, notice the Type is set to Minute and the Value is set 

to 5.  This means that NinjaTrader uses a five-minute chart.  Right click and click “Set Default…”  Our 

strategies mostly use five-minute charts and this is our recommendation.  Keep scrolling down.  Under days to 

load, type in 30.  This will load 30 days of price data so you can scroll back and see charts for previous days.  

For Session template, select Default 24/7.  This will make sure you are pulling in overnight data. Click OK at 

the bottom and then the chart will open.  Congratulations – you now have your first live trading chart 

open! 

mailto:support@daytradetowin.com
http://www.cmegroup.com/trading_hours/
http://daytradetowin.com/faq.php#rollover-102
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This configuration we have just set is what we recommend for most of our strategies.  When you open charts 

for other markets (those offered in the CQG demo - ES, YM, DX, CL, DAX, etc.) you will need to configure 

these parameters again.  When you purchase our courses, different time frames may be suggested (especially 

our Trade Scalper course). 

 To navigate between days, drag the scroll bar on the bottom of the chart or hold the Ctrl key while 

dragging the time axis with your mouse.  You can stretch or shrink your view of the time axis by 

dragging the time axis with your mouse.  To navigate up and down on the price axis, hold the Ctrl 

key while dragging the price axis with your mouse.  You can stretch or shrink your view of the price axis 

by dragging the price axis with your mouse.  If you lose sight of the candles, click the small F (focus) 

button in the upper right corner of the chart.  This will “lock” your view to the price bars, allowing you to 

scroll through history without losing sight of price. 

 

 To easily find the price or time at which a bar plots, click the Pointer / Cross Hair tool and select the 

Cross Hair.  The Global Cross Hair is great if you’re managing multiple charts (advanced) and want 

your cross hair to be consistent throughout. 

 

 You can switch markets by clicking the Market and contract month.  Keep in mind that markets are 

open at different times. 

 

 You can switch time frames.  Get a broader look at the market by selecting a day or monthly chart.  

Most of the time, we trade with 5, 10 or 15 minute charts.  When scalping, we will either use 1 minute or 

tick charts.  Scalping focuses on making profit by placing trades in quick succession for short time 

frames. 

Common chart features in NinjaTrader 7 

 

  

http://daytradetowin.com/the-trade-scalper.php
http://daytradetowin.com/the-trade-scalper.php
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We recommend candle (or candlestick) charts.  Why?  Because they offer an excellent representation of how 

price behaved.  If you are looking at a five minute chart, a single candle represents where price moved within 

that five minutes.   

When a candle’s closing price is below its opening price, the candle is colored red.  When a candle’s closing 

price is above its opening price, the candle is colored green. 

 

 

 

 

 

On occasion, you will see “empty” candles that look like this: †.  These candles are called “dojis” and occur 

when a candle’s opening and closing prices are the same.  Be sure to zoom in on your chart to really see if a 

candle is a doji or not.   

A bit of understanding of price is also helpful in learning about the formation of candles.  In the E-mini S&P, the 

smallest amount price can move is .25.  On E-mini charts, you will always see the price in multiples of .25.  

This .25 is called the tick size.  In other words, each tick is worth $12.50 per contract traded.  Four ticks are 

considered one point.  Our methods at Day Trade to Win focus on winning you two to four points ($100 to 

$200) each day, per contract.  If you trade 10 contracts with consistent success, you can make quite a living!  

Each market has its own tick size, so be sure to check with your broker or the exchange for price details. 

Now that we have a chart open, how do we place trades?  There are a couple of different ways you can place 

orders, or trades, referencing your chart.  The first way is to use NinjaTrader’s Chart trader.  After clicking the 

Chart trader button, you will see a panel slide out on the right of the chart.  While this feature is handy, we 

recommend using a Dynamic SuperDOM for placing orders instead.  We refer to the Dynamic  SuperDOM as 

the “DOM.”   Think of the DOM as a remote controller for interacting with the market.  In other trading 

platforms, the DOM is called a price ladder or matrix.  Open a DOM via NinjaTrader’s Control Center > File > 

New Dynamic SuperDOM.  The DOM window should say “Sim101” on top to indicate that you are trading with 

NinjaTrader’s simulation account.  Click the Instrument drop-down box and select the market that you have 

open in your chart.  You should see price moving on the chart with a number of BUY and SELL orders on each 

side. 

Now, perhaps the most difficult part of trading is understanding the different types of orders and how to place 

them using the DOM.  We highly recommend that you watch the SuperDOM training videos in the NinjaTrader 

video library.  Click the “+” next to SuperDOM and then see each video.  Be sure to check out the videos under 

the “Submitting Orders” heading.  NinjaTrader also conducts webinars to teach SuperDOM basics. We also 

recommend reading this article on Investopedia. 

As a side note, when you close NinjaTrader, you will be asked to save your workspace.  A workspace is all of 

the charts and windows that you currently have up.  If you choose to save your workspace, the next time 

NinjaTrader loads, all of the same windows will load up again.  It’s a great time saver! 

 

 

Price opened here 

Price closed here 

Price “traveled” within here and “hit” these prices during chart’s given time period 

http://en.wikipedia.org/wiki/Doji
http://www.ninjatrader.com/support/helpGuides/nt7/index.html?video_library.htm
http://www.ninjatrader.com/webinars
http://www.investopedia.com/university/how-to-use-ninjatrader-trading-software/ninja-trader4.asp


Ed. 2.19.13 Get Started Day Trading © 2013 Day Trade To Win  Page 9 

Part 5 – Learn These Money-Making Strategies 

Now that you are comfortable placing simulated trades with your real-time data feed, you need to learn a 

strategy that stands a good chance of making you money.  Remember, you need to practice the strategy with 

simulated data first before opening an account with a broker. 

Click here to watch three videos that will teach you exact trading strategies. 

Three free training videos on the Day Trade to Win website

 

At Day Trade to Win, we teach traders how to be consistently successful.  Take a look at our day trading 

courses to find out more.The most common question we get is, “what course is right for me?” 

Most beginner traders prefer to start off with our Six-Month Atlas Line or our Power Price Action Course.  Many 

traders like to enroll in the Group Mentorship Program so they can learn everything we offer through eight 

weeks of live training with John Paul. 

 

http://daytradetowin.com/videos.php
http://daytradetowin.com/courses.php
http://daytradetowin.com/courses.php
http://daytradetowin.com/software.php
http://daytradetowin.com/power-price-action.php
http://daytradetowin.com/mentorship.php
http://daytradetowin.com/videos.php
http://daytradetowin.com/courses.php
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Our Mentorship Program places you with John Paul in a virtual training room where you can learn his methods 

by looking at his daily charts.  He fully explains the rules for every trade: how and when to enter, where your 

profit target and stop loss should be, what to do if a trade goes against you, and much more.  In total, about 11 

unique strategies are taught.  By the end of the eight weeks of training, you know exactly how to handle 

any trading situation, take profit and minimize risk.   

All of our courses and software are included with Mentorship plus many others that are Mentorship-only 

 

Watch the many video testimonials from our students. 

To register for the Mentorship Program or inquire about costs, email us at support@daytradetowin.com or call 

us at 888-607-0008. 

 

 

 

 

 

CFTC RULE 4.41 – HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, 

SIMULATED RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT BEEN EXECUTED, THE RESULTS MAY HAVE UNDER-OR-

OVER COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN 

GENERAL ARE ALSO SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO REPRESENTATION IS BEING MADE THAT ANY 

ACCOUNT WILL OR IS LIKELY TO ACHIEVE PROFIT OR LOSSES SIMILAR TO THOSE SHOWN. 

GOVERNMENT REGULATIONS REQUIRE DISCLOSURE OF THE FACT THAT WHILE THESE METHODS MAY HAVE WORKED IN THE PAST, PAST RESULTS ARE 

NOT NECESSARILY INDICATIVE OF FUTURE RESULTS. WHILE THERE IS A POTENTIAL FOR PROFITS THERE IS ALSO A RISK OF LOSS. A LOSS INCURRED IN 

CONNECTION WITH TRADING FUTURES CONTRACTS CAN BE SIGNIFICANT. YOU SHOULD THEREFORE CAREFULLY CONSIDER WHETHER SUCH TRADING IS 

SUITABLE FOR YOU IN LIGHT OF YOUR FINANCIAL CONDITION SINCE ALL SPECULATIVE TRADING IS INHERENTLY RISKY AND SHOULD ONLY BE 

UNDERTAKEN BY INDIVIDUALS WITH ADEQUATE RISK CAPITAL. 

ANY ADVISORY OR SIGNAL GENERATED BY DAY TRADE TO WIN IS PROVIDED FOR EDUCATIONAL PURPOSED ONLY. ANY TRADES PLACED UPON RELIANCE 

ON WWW.DAYTRADETOWIN.COM SYSTEMS ARE TAKEN AT YOUR OWN RISK FOR YOUR OWN ACCOUNT. PAST PERFORMANCE IS NO GUARANTEE OF 

FUTURE RESULTS. WHILE THERE IS GREAT POTENTIAL FOR REWARD TRADING COMMODITY FUTURES, THERE IS ALSO SUBSTANTIAL RISK OF LOSS IN ALL 

TRADING. YOU MUST DECIDE YOUR OWN SUITABILITY TO TRADE OR NOT. FUTURES RESULTS CAN NEVER BE GUARANTEED. THIS IS NOT AN OFFER TO BUY 

OR SELL FUTURES OR COMMODITY INTERESTS. 

READ OUR FULL RISK DISCLOSURE AND DISCLAIMER STATEMENT. 

http://daytradetowin.com/mentorship.php
http://daytradetowin.com/testimonials.php
mailto:support@daytradetowin.com
http://daytradetowin.com/risk.php
http://daytradetowin.com/mentorship.php

